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“Education is not the learning of facts, but the 

training of the mind to think” 

-Albert Einstein- 
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SARI BACAAN 

Aliran air sangat bergantung kepada kondisi tata guna lahan di permukaan bumi. 

Penelitian ini menduga bahwa distribusi curah hujan berinteraksi langsung dengan 

bentuk topografi, sehingga dapat memperkirakan arah aliran dan besar debit aliran 

di sungai. Bentuk topografi dapat menunjukkan arah aliran dari dataran tinggi ke 

dataran rendah. Adapun tujuan penelitian ini adalah memetakan kontur distribusi 

curah hujan, kontur topografi, arah pengaliran presipitasi lokasi penelitian, dan 

menghitung debit aliran permukaan di lokasi penelitian. Data yang dikumpulkan 

dalam penelitian ini merupakan data sekunder, yaitu data curah hujan dan hari 

hujan yang berasal dari BMKG, data topografi DEM SRTM yang berasal dari 

LAPAN, data shapefile batas DAS, sungai dan peta penggunaan lahan yang 

berasal dari Badan Informasi Geospasial (BIG). Hasil dari pemetaan kontur curah 

hujan pada tahun 2012 hingga 2017 menunjukkan nilai terendah 327 mm/tahun 

hingga nilai tertinggi 5346 mm/tahun, hasil pemetaan kontur topografi 

menunjukkan nilai terendah 745 meter dan nilai tertinggi 4279 meter, hasil dari 

pemetaan arah aliran menunjukkan bahwa aliran akan bergerak terus menuju 

sungai-sungai besar beserta cabangnya, dan hasil dari perhitungan debit 

maksimum ada pada bulan Januari yang terletak pada DAS Sungai Jeneberang 

dengan nilai 1,77 liter/detik dan nilai debit minimum ada pada bulan Agustus 

yang terletak pada DAS Binangapapa dengan nilai 0,07 liter/detik. 

Kata Kunci: Arah aliran, kontur, curah hujan, topografi, debit 
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ABSTRACT 

The flow of water depends on the conditions of land use on the surface of the 

earth. This study suggested that the distribution of rainfall interacted directly with 

the topographic shape, so as to predict the flow direction and the large flow rate in 

the river. Topographic shape could show the direction of flow from the plateau to 

the lowlands. The objectives of this study were to map out the contours of rainfall 

distribution, topographic contour, precipitation drainage direction, and calculate 

surface flow discharge at the research site. The data collected in this study were 

secondary data, rainfall data and data of rainy days from BMKG, DEM SRTM 

topographic data derived from LAPAN, shapefile data of watershed boundaries, 

rivers and land use maps from the Badan Informasi Geospasial (BIG) . The results 

of the rainfall contour mapping in 2012 to 2017 show the lowest value of 327 mm 

/ yr up to the highest value of 5346 mm / yr, the topographic contour mapping 

results show the lowest value of 745 meters and the highest value of 4279 meters, 

the result of mapping the flow direction indicates that the flow will moving 

towards the major rivers along with its branches, and the result of the maximum 

discharge calculation is in January located on the Jeneberang River watershed 

with a value of 1.77 liters / sec and the minimum discharge value is in August 

located in the Binangapapa watershed with a value of 0,07 liters / sec. 

Keywords :  Flow direction, contour, rainfall, topography, discharge 
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BAB I 

PENDAHULUAN 

I.1 Latar Belakang 

Air merupakan sumber daya alam yang paling berharga, karena tanpa adanya air 

tidak mungkin terdapat kehidupan. Air tidak hanya dibutuhkan untuk kehidupan 

manusia, hewan dan tanaman, tetapi juga merupakan media pengangkutan, 

sumber energi dan berbagai keperluan lainnya. Pada suatu saat dalam bentuk 

hujan lebat dan banjir, aliran air juga dapat memiliki daya perusak, menimbulkan 

kerugian harta dan jiwa, serta menghanyutkan sejumlah volume tanah subur 

(Suripin, 2004). 

 

Ilmu yang mempelajari proses pengaturan kehilangan dan penambahan serta 

penampungan sumber-sumber air di bumi adalah hidrologi. Dua besaran ekstrim 

dalam hidrologi adalah ekstrim maksimum berupa banjir dan ekstrim minimum 

berupa kekeringan. Mengingat pentingnya sungai bagi kehidupan manusia, maka 

keadaan ekstrim alirannya, baik kekeringan maupun banjir tidak dikehendaki. 

Terutama untuk kasus banjir, perlindungan terhadap berbagai aspek kehidupan di 

sepanjang sungai perlu diperhatikan. Di dalam analisis hidrologi, salah satu hasil 

akhir yang sering diharapkan adalah perkiraan besar banjir (hujan) rancangan 

untuk suatu bangunan hidraulik tertentu (Harto, 1993). 

 

Aliran air sangat bergantung kepada kondisi tata guna lahan di permukaan bumi. 

Bila tidak ada daerah yang bisa menyerap dan daerah yang bisa menahan laju 

aliran maka pada waktu musim penghujan air akan mengalir langsung ke laut. 
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Pada waktu musim kemarau karena tidak ada lagi hujan maka keberadaan air di 

suatu tempat tergantung dari kuantitas dan kualitas resapan dan penahan air pada 

waktu musim penghujan. Dengan resapan maupun penahan air yang baik dan 

optimal maka kebutuhan air dapat terpenuhi di musim kemarau karena masih ada 

air yang tertampung dan terhenti misalnya : waduk, danau dan lain-lain serta yang 

meresap di dalam tanah sehingga membentuk air tanah, sumur, mata air dan lain-

lain (Kodoatie dan Syarief, 2005). 

 

Penelitian ini menduga bahwa distribusi curah hujan berinteraksi dengan bentuk 

topografi dapat memperkirakan besaran aliran permukaan sampai kepada besar 

aliran debit di sungai. Bentuk topografi dapat memperlihatkan aliran dari dataran 

tinggi ke dataran rendah (Pawitan, 2004). 

  

Penelitian distribusi pengaliran presipitasi berdasarkan topografi ini dilakukan 

untuk menganalisis arah aliran presipitasi melalui peta kontur topografi sehingga 

didapat wilayah yang berpotensi tinggi mengalami arah aliran yang tinggi di 

wilayah Kota Makassar, Kabupaten Gowa dan Kabupaten Takalar. Arah 

pengaliran presipitasi di wilayah tersebut dapat diketahui dari peta kontur 

topografi wilayah Kota Makassar, Kabupaten Gowa dan Kabupaten Takalar, 

sedangkan debit curah hujan dapat diketahui dari peta sebaran curah hujan di 

wilayah Kota Makassar, Kabupaten Gowa dan Kabupaten Takalar (Rostianingsih, 

2004). 
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Hasil akhir yang diharapkan dalam penelitian ini adalah memperlihatkan arah 

aliran air yang mengalir dari hasil presipitasi dan memperkirakan debit aliran 

tertinggi di wilayah penelitian. 

 

I.2 Rumusan Masalah 

Pada penelitian yang dilakukan oleh Muchsin tahun 2011, prakiraan daerah 

terjadinya banjir hanya pada lokasi penelitian di Makassar dan menggunakan data 

curah hujan selama 1 tahun yang menyebabkan hasil dari penelitian kurang 

akurat. Selain itu sebaran curah hujan yang kurang merata dan bentuk topografi 

yang berbeda setiap wilayah menyebabkan perbedaan pengaliran curah hujan. 

Oleh karena itu perlu dilakukan penelitian yang mengkaji hubungan antara curah 

hujan dan topografi dengan membuat peta kontur masing-masing untuk 

mendapatkan hasil yang baik. Adapun permasalahan pokok yang dirumuskan 

sebagai berikut: 

 Bagaimana distribusi curah hujan dapat memperkirakan pola besar dan 

arah aliran permukaan di atas bentang topografi? 

 

I.3 Ruang Lingkup Penelitian 

Pada penelitian ini dilakukan pemetaan kontur distribusi curah hujan di wilayah 

Kota Makassar, Kabupaten Gowa dan Kabupaten Takalar selama  periode 2012-

2017 dan pemetaan kontur topografi Kota Makassar, Kabupaten Gowa dan 

Kabupaten Takalar. Untuk membuat peta kontur curah hujan, dibutuhkan data real 

curah hujan yang didapatkan dari pengamatan BMKG (Badan Meteorologi 
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Klimatologi dan Geofisika), lalu hasilnya diolah menggunakan software ArcGIS. 

Dari pengolahan tersebut akan memperlihatkan wilayah mana yang sering 

mengalami presipitasi tinggi, hari hujan yang sering dan memperkirakan debit 

aliran. Selanjutnya untuk membuat peta kontur topografi di wilayah penelitian, 

dibutuhkan data ketinggian yang didapatkan dari data topografi. 

I.4 Tujuan Penelitian 

Tujuan dari penelitian ini adalah : 

1. Memetakan kontur distribusi curah hujan. 

2. Memetakan kontur topografi untuk memberikan informasi tentang tinggi 

rendah toporafinya lokasi penelitian.  

3. Memetakan arah pengaliran presipitasi Kota Makassar, Kabupaten Gowa dan 

Kabupaten Takalar berdasarkan topografi.  

4. Menghitung debit aliran permukaan Kota Makassar, Kabupaten Gowa dan 

Kabupaten Takalar. 
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BAB II 

TINJAUAN PUSTAKA 

II. 1  Hidrologi 

II.1.1 Siklus Hidrologi 

Siklus hidrologi adalah suatu rangkaian proses yang terjadi dengan air 

yang terdiri dari penguapan, presipitasi, infiltrasi dan pengaliran keluar 

(out flow). Penguapan terdiri dari evaporasi dan transpirasi. Uap yang 

dihasilkan mengalami kondensasi dan dipadatkan membentuk awan yang 

nantinya kembali menjadi air dan turun sebagai presipitasi. Sebelum tiba 

di permukaan bumi presipitasi tersebut sebagian langsung menguap ke 

udara, sebagai tertahan oleh tumbuh-tumbuhan (intersepsi) dan sebagian 

mencapai permukaan tanah (Soewarno, 2000).  

Terdapat tiga variabel utama hujan yang hampir selalu diamati untuk 

berbagai kebutuhan analisa, prediksi dan perencanaan, yaitu ketebalan 

hujan (R), durasi hujan (t), dan distribusinya dalam ruang dan waktu. 

Berdasarkan tiga variabel utama ini, dapat diturunkan variabel hujan lain, 

antara lain intensitas hujan (I) dan probabilitas hujan atau periode ulang 

kejadian hujan (T) (Asbintari dkk, 2016). 

Curah hujan didefinisikan sebagai tinggi air hujan (dalam mm) yang 

diterima di permukaan sebelum mengalami aliran permukaan, evaporasi 

dan peresapan atau perembesan ke dalam tanah. Jumalah hari hujan 

dibatasi oleh jumlah hari dengan tinggi curah hujan 0,5 mm atau lebih. 
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Jumlah hari hujan dinyatakan per minggu, dekade, bulan, tahun atau satu 

periode tanam. Sedangkan jumlah curah hujan dicatat dalam inci atau 

milimeter (1 inci = 25,4 mm). Jumlah curah hujan 1 mm, menunjukkan 

tinggi air hujan yang menutupi permukaan bumi 1 mm, jika air tersebut 

tidak meresap ke dalam tanah atau menguap ke atmosfer (Hermawan, 

2009). 

Air yang sampai ke permukaan tanah sebagian akan berinfiltrasi dan 

sebagian lagi mengisi lekuk-lekuk permukaan tanah kemudian mengalir 

ke tempat yang lebih rendah, masuk ke sungai-sungai dan akhirnya ke 

laut. Dalam perjalanannya menuju laut sebagian akan mengalami 

penguapan. Air yang masuk ke dalam taah sebagian akan keluar lagi 

menuju sungai yang disebut dengan aliran intra (interflow). Sebagian lagi 

akan terus turun dan masuk ke dalam air tanah yang keluar sedikit demi 

sedikit dan masuk ke dalam sungai sebagai aliran bawah tanah 

(groundwater flow), dan begitu seterusnya. Proses mengenai siklus 

hidrologi dapat dilihat pada Gambar 2.1 berikut: 
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Gambar 2.1 Siklus Hidrologi (Wibowo, 2005) 

Presipitasi mungkin terbentuk sebagai hujan, salju, atau hujan es. 

Sebagian atau seluruh hasil presipitasi tersebut dapat menguap sebelum 

mencapai permukaan tanah. Hasil presipitasi yang mencapai permukaan 

tanah mungkin diintersepsi oleh vegetasi atau meresap ke dalam 

permukaan tanah atau menguap atau menjadi limpasan permukaan. 

Penguapan dapat terjadi dari permukaan tanah, air atau daun tumbuhan 

melalui proses transpirasi. Air hujan yang bergerak di permukaan bumi 

disebut limpasan permukaan sedangkan yang bergerak ke dalam 

permukaan tanah disebut infiltrasi (Wibowo, 2005).  

Setiap turun hujan, tidak semua air hujan teresap ke dalam tanah. Air 

yang tidak teresap berupa aliran permukaan. Aliran permukaan akan 

mengalir ke daerah yang lebih rendah dan menuju saluran-saluran air. 

Wilayah bagian hulu dan bagian hilir memiliki keterkaitan geofisik 

melalui daur hidrologi (Utomo dkk, 2012). 
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Aliran permukaan memiliki daya gerus tanah atau membawa materi 

tanah (sedimen) yang dalam saluran air akan dihitung sebagai suspensi. 

Erosi yang tinggi akan menyebabkan muatan sedimen yang terbawa oleh 

aliran permukaan meningkat. Erosi akan memengaruhi besarnya debit 

suspensi pada daerah aliran sungai wilayah tersebut (Utomo dkk, 2012). 

II.1.2 Presipitasi 

Hujan adalah salah satu bentuk dari presipitasi. Presipitasi adalah uap 

yang mengkondensasi dan jatuh ke tanah dalam rangkaian proses siklus 

hidrologi. Hujan merupakan unsur iklim yang paling penting di daerah 

tropis seperti di Indonesia karena keragamannya sangat tinggi, baik 

menurut waktu maupun menurut tempat. Sehingga kajian tentang iklim 

lebih banyak diarahkan pada hujan (Hermawan, 2009).  

Curah hujan yang diperlukan untuk penyusunan suatu rancangan 

pemanfaatan air dalam rancangan pengendalian banjir adalah curah hujan 

rata-rata di seluruh daerah yang bersangkutan, bukan curah hujan pada 

suatu titik tertentu. Curah hujan ini disebut curah hujan wilayah atau 

daerah dan dinyatakan dalam mm (Sosrodarsono, 2003). 

 

Presipitasi yang berupa hujan dan salju dapat terjadi karena adanya 

tabrakan antara butir-butir uap air akibat desakan angin. Besarnya 

presipitasi di tempat satu dengan yang lainnya tidak sama. Bentuk 

presipitasi yang ada di Indonesia adalah hujan. Berdasarkan evaluasi 
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curah hujan yang dilakukan oleh BMKG menunjukkan bahwa Sulawesi 

Selatan  merupakan daerah yang berpeluang mengalami curah hujan di 

atas 400 mm/bulan. Curah hujan adalah faktor utama yang 

mengendalikan berlangsungnya daur hidrologi dalam suatu wilayah DAS 

(merupakan elemen utama yang perlu diketahui mendasari pemahaman 

tentang kelembaban tanah, proses resapan air tanah, dan debit aliran). 

Seperti diketahui bahwa keterlanjutan proses ekologi, geografi dan 

tataguna lahan di suatu DAS ditentukan oleh berlangsungnya daur 

hidrologi, dan dengan demikian, presipitasi dapat dipandang sebagai 

faktor pendukung sekaligus pembatas bagi usaha pengelolaan 

sumberdaya air dan tanah. Para perencana pengelolaan DAS, terutama 

pengelolaan sumberdaya air harus menyadari pentingnya memahami 

proses dan mekanisme terjadinya presipitasi, terutama hal-hal yang 

berkaitan dengan bagaimana caranya mengkuantifikasi dan melakukan 

analisis tentang karakteristik presipitasi yang sangat bervariasi, 

bagaimana cara pengukurannya, serta dalam bentuk apa data presipitasi 

seharusnya dilaporkan (Asdak, 2007). 

Karakteristik hujan (lama, tebal dan intensitas hujan) pada suatu wilayah 

sangat memengaruhi besarnya debit aliran pada suatu DAS  (baik dalam 

volume tubuh air maupun kecepatan alirannya) dan erosi yang terjadi 

pada daerah tersebut. Setiap kejadian hujan memliki karakter masing-

masing. Karakter tersebut dapat berupa lama, tebal dan intensitas hujan. 

Intensitas hujan maksimal selama 30  menit merupakan intensitas yang 



 

 
10 

akan memberikan pengaruh besar terhadap aliran permukaan. Ketiga 

karakter hujan di atas akan dikaitkan dengan besarnya volume aliran dan 

berat suspensi yang terjadi (Utomo dkk, 2012). 

Tabel 2.1 Kategori Curah Hujan Bulanan  

Kategori Curah Hujan Intensitas (mm/bulan) 

Hujan rendah 0 – 100 

Hujan menengah 101 – 300 

Hujan tinggi 301 – 400 

Hujan sangat tinggi                             > 400 

Sumber: Ridwan, 2016 

Tabel 2.2 Kategori Curah Hujan Tahunan 

Kategori Curah Hujan Intensitas (mm/tahun) 

Hujan ringan 0 – 2000 

Hujan sedang 2001 – 3000 

Hujan lebat >3001 

Sumber: Ridwan,2016 

Pada Tabel 2.1, curah hujan bulanan dapat dikategorikan menjadi 4 

kategori berdasarkan besar intensitasnya yaitu, hujan rendah dengan nilai 

intensitas antara 0 mm/bulan hingga 100 mm/bulan, hujan menengah 

dengan nilai 101 mm/bulan hingga 300 mm/bulan, hujan tinggi dengan 
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nilai 301 mm/bulan hingga 400 mm/bulan, dan hujan sangat tinggi 

dengan nilai intensitas lebih dari 400 mm/bulan. Sedangkan pada Tabel 

2.2, curah hujan tahunan dapat dikategorikan menjadi 3 kategori 

berdasarkan besar intensitasnya yaitu, hujan ringan dengan nilai 

intensitas antara 0 mm/tahun hingga 2000 mm/tahun, hujan sedang 

dengan nilai 2001 mm/tahun hingga 3000 mm/tahun, dan hujan lebat 

dengan nilai intensitas lebih 3001 mm/tahun (Ridwan, 2016). 

II.1.3 Debit Aliran Air 

Debit aliran adalah jumlah air yang mengalir dalam satuan volume per 

waktu. Debit adalah satuan besaran air yang keluar dari Daerah Aliran 

Sungai (DAS). Satuan debit yang digunakan adalah meter kubik per detik 

(m3/s). debit aliran adalah laju aliran (dalam bentuk volume air) yang 

melewati suatu penampang melintang sungai per satuan waktu (Asdak, 

2002). 

Dalam praktek, sering variasi kecepatan pada tampang lintang diabaikan, 

dan kecepatan aliran dianggap seragam di setiap titik pada tampang 

lintang yang besarnya sama dengan kecepatan rerata, sehingga debit 

aliran dapat dirumuskan sebagai berikut: 
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Q = 0,0028. [
  

 
   ] [

  

 
   ]      (2.1) 

Q   = Debit aliran (l/det) 

0,0028 = Konstanta, digunakan jika satuan luas daerah menggunakan Ha 

Ci   = Koefisien aliran menurut tata guna lahan berdasarkan DAS 

Ii   = Intensitas Curah Hujan berdasarkan DAS (mm/bulan) 

Ai  = Luas daerah aliran berdasarkan DAS (Ha) 

A  = Luas daerah aliran (Ha) 

 

Tabel 2.3 Nilai C Menurut Tata Guna Lahan 

Jenis Penggunaan Lahan Nilai C 

Lahan Terbuka 0,015 

Semak-Semak 0,016 

Tugu Air 0,01 

Pertanian 0,026 

Bukit 0,041 

Lahan Terbangun 0,059 

Hutan 0,07 

(Tanaka, 2007) 

Pada Tabel 2.3, Nilai C menurut tata guna lahan pada wilayah Kota 

Makassar, Kabupaten Gowa, dan Kabupaten Takalar dapat dijeniskan 

menjadi 8 jenis, yaitu jenis lahan kosong yang mempunyai nilai C 0,015, 
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jenis semak-semak yang mempunyai nilai C 0,016, jenis perairan yang 

mempunyai nilai C 0,01, jenis pertanian yang mempunyai nilai C 0,026, 

jenis bukit yang mempunyai nilai C 0,041, jenis permukiman yang 

mempunyai nilai C 0,059, jenis hutan yang mempunyai nilai C 0,07 dan 

jenis perkotaan yang mempunyai nilai C 0,053 (Tanaka, 2007)  

Debit adalah suatu koefisien yang menyatakan banyaknya air yang 

mengalir dari suatu sumber persatuan waktu, biasanya diukur dalam 

satuan liter per detik, untuk memenuhi kebutuhan kebutuhan air 

pengairan, debit air harus lebih cukup untuk disalurkan ke saluran yang 

telah disiapkan. Pada dasarnya debit air yang dihasilkan oleh suatu 

sumber air ditentukan oleh beberapa faktor yaitu (Dumiary, 1992): 

1. Intensitas hujan 

2. Penggundulan hutan 

3. Pengalihan hutan menjadi lahan pertanian 

4. Intersepsi 

5. Evaporasi dan transpirasi 

Debit air merupakan komponen yang penting dalam pengelolaan suatu 

DAS. Pelestarian hutan juga penting dalam rangka menjaga kestabilan 

debit air yang ada di DAS, karena hutan merupakan faktor utama dalam 

hal penyerapan air tanah serta dalam proses evaporasi dan transpirasi, 

juga pengendali terjadinya longsor yang mengakibatkan permukaan 
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sungai menjadi dangkal, jika terjadi pendangkalan sungai, maka debit air 

yang ada di sungai pun akan berkurang (Dumiary, 1992) 

 

II. 2 Topografi  

II.2.1 Topografi 

Topografi permukaan atau bentuk lahan mempengaruhi aliran permukaan 

(run off) dan aliran air bumi. Aliran permukaan (surface runoff) 

meningkat dengan meningkatnya lereng. Tanah, geologi, geomorfologi, 

dari suatu DAS, berfungsi sebagai kontrol terhadap besar kecilnya 

infiltrasi dan kapasitas menahan air permukaan. Daerah permukaan yang 

miring akan menyebabkan aliran permukaan yang deras dan besar bila 

dibandingkan dengan daerah yang agak datar (Muchtar dkk, 2007). 

Peta topografi merupakan peta yang memuat informasi umum tentang 

keadaan permukaan tanah beserta informasi ketinggiannya menggunakan 

garis kontur, yaitu garis pembatas bidang yang merupakan tempat 

kedudukan titik-titik dengan ketinggian sama terhadap bidang referensi 

(pedoman/acuan) tertentu (Rostianingsih, 2004). 

 

II.2.2 Konsep Dasar Sistem Informasi Geografis (SIG) 

 Sistem Informasi Geografis (SIG) adalah suatu kumpulan alat (tools) 

yang digunakan untuk pengumpulan, penyimpanan, pengaktifan sesuai 

kehendak, pentransformasian, serta penyajian data spasial dari suatu 



 

 
15 

fenomena nyata di permukaan bumi untuk tujuan tertentu (Muchsin, 

2011). 

Hal yang dapat membedakan sistem informasi geografis (SIG) dengan 

program-program yang lainnya adalah bahwa seluruh data dalam SIG 

adalah bersifat Geo-refferenced, seperti lokasi yang harus didasarkan 

pada sistem koordinat yang baku. Menurut (Prahasta, 2005) dalam 

(Ridwan, 2017) ada beberapa alasan yang menyebabkan aplikasi SIG 

menjadi menarik untuk digunakan di berbagai disiplin ilmu, antara lain. 

       II.2.2.1 Metode-Metode Pembuatan Kontur Curah Hujan 

1. Metode Interpolasi 

Interpolasi adalah metode untuk mendapatkan data berdasarkan 

beberapa data yang diketahui. Dalam pemetaan, interpolasi adalah 

proses estimasi nilai pada wilayah yang tidak disampel atau 

diukur, sehingga terbuatlah peta atau sebaran nilai pada seluruh 

wilayah. Didalam melakukan interpolasi, sudah pasti dihasilkan. 

Error yang dihasilkan sebelum melakukan interpolasi bisa 

dikarenakan kesalahan menentukan metode sampling data, 

kesalahan dalam pengukuran, dan kesalahan dalam analisa di 

laboratorium (Pramono, 2008). 

2. Metode IDW  

Metode IDW (Inverse Distance Weighted) merupakan metode 

deterministik yang sederhana dengan mempertimbangkan titik 
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di sekitarnya. Asumsi dari metode ini adalah nilai interpolasi 

akan lebih mirip pada data sampel yang dekat daripada yang 

lebih jauh. Bobot (weight) akan berubah secara linear sesuai 

dengan jaraknya dengan data sampel. Bobot ini tidak akan 

dipengaruhi oleh letak dari data sampel. Kerugian dari metode 

IDW adalah nilai hasil interpolasi terbatas pada nilai yang ada 

pada data sampel. Pengaruh dari data sampel terhadap hasil 

interpolasi disebut sebagai isotropic. Untuk medapatkan hasil 

yang terbaik, sampel data yang digunakan harus rapat yang 

berhubungan dengan variasi lokal (Pramono, 2008). 

3. Metode Kriging 

Metode kriging adalah estimasi stochastic yang mirip dengan 

metode IDW dimana menggunakan kombinasi linear dari 

weight untuk memperkirakan nilai diantara sampel data. 

Asumsi dari metode ini adalah jarak dan orientasi antara 

sampel data menunjukkan korealsi spasial yang penting dalam 

hasil interpolasi. Metode Kriging sangat banyak menggunakan 

sistem komputer dalam perhitungan. Kecepatan perhitungan 

tergantung dari banyaknya sampel data yang digunakan dan 

cakupan dari wilayah yang diperhitungkan. Tidak seperti 

metode IDW, Kriging memberikan ukuran error dan 

confidence. Metode ini menggunakan semivariogram yang 

mempresentasikan perbedaan spasial dan nilai diantara semua 
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pasangan sampel data. Semivariogram juga menunjukkan 

bobot (weight) yang digunakan dalam interpolasi. 

Semivariogram dihitung berdasarkan sampel semivariogram 

dengan jarak h, beda nilai z dan jumlah sampel data n. Pada 

jarak yang dekat (sumbu horisontal), semivariance bernilai 

kecil.Tetapi pada jarak yg lebih kecil, semivariance bernilai 

tinggi yang menunjukkan bahwa variasi dari nilai z tidak lagi 

berhubungan dengan jarak sampel point. Jenis Kriging yang 

bisa dilakukan adalah dengan cara spherical, circular, 

exponential, gaussian dan linear. Tahapan dalam menggunakan 

metode ini adalah analisa statistik dari sampel data, pemodelan 

variogram, membuat hasil interpolasi, dan menganalisis nilai 

variance. Metode ini sangat tepat digunakan bila kita 

mengetahui korelasi spasial jarak dan orientasi dari data. Oleh 

sebab itu, metode ini sering digunakan dalam bidang ketanahan 

dan geologi. Kelemahan dari metode ini adalah tidak dapat 

menampilkan puncak, lembah atau nilai yang berubah drastis 

dalam jarak yang dekat (Pramono, 2008)    
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BAB III 

METODOLOGI PENELITIAN 

III.1 Lokasi Penelitian 

Lokasi yang dijadikan daerah penelitian berada di Kota Makassar, Kabupaten 

Gowa dan Kabupaten Takalar. Kota Makassar terletak pada koordinat 5°8' LU 

dan 119°25' BT, dengan luas wilayah sebesar 199,26 km
2
. Kabupaten Gowa 

terletak pada koordinat 5°33'6‖ sampai  5°34'7‖ LS dan 120°38'6‖ sampai 

120°33'6‖ BT, dengan luas wilayahnya 1.883 km
2
. Dan Kabupaten Takalar 

terletak pada koordinat 5,3° sampai  5,33° LS dan 119,22° sampai 118,39° BT, 

dengan luas wilayahnya 566,51 km
2
. Dan lokasi keseluruhannya sebesar 

2648,77 km
2
. Lokasi penelitian dapat dilihat pada Gambar 3.1. 

Gambar 3.1 Peta Lokasi Penelitian 
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III.2 Alat dan Bahan 

III.2.1 Peralatan yang digunakan dalam penelitian ini antara lain : 

1. Data Citra Google Earth 

2. Software pengolah data berupa: 

 ArcGIS 10.0 Lisensi Fakultas MIPA Unhas 

 Microsoft Office Excel 2010 

III.2.2 Bahan yang digunakan dalam penelitian ini antara lain : 

1. Data curah hujan Kota Makassar, Kabupaten Gowa dan Kabupaten Takalar 

tahun 2012 - 2017 dari BMKG 

2. Data hari hujan Kota Makassar, Kabupaten Gowa dan Kabupaten Takalar 

tahun 2012 - 2017 dari BMKG 

3. Data Batas DAS dari BAPPEDA Provinsi Sulawesi Selatan 

4. Data Sungai dari BIG (Badan Informasi Geospasial) 

5. Data Topografi DEM SRTM Sulawesi Selatan dari LAPAN resolusi 30 m - 

1 Arc-Second 

6. Peta Penggunaan Lahan bersumber dari BIG (Badan Informasi Geospasial) 

III.3 Tahapan Penelitian 

Pada tahapan ini merupakan tahap awal dalam melaksanakan penelitian berupa 

pengumpulan data dan literatur yang berhubungan dengan penelitian, menentukan 

alat dan bahan dalam pengambilan dan pemrosesan data, serta pemilihan bahan 

yang dipakai.  
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III.3.1 Persiapan 

1. Menyiapkan data curah hujan Kota Makassar, Kabupaten Gowa dan Kabupaten 

Takalar periode 2012 - 2017 dari BMKG 

2. Menyiapkan data  pendukung berupa data DEM. Data DEM digunakan untuk 

mengoreksi dan mengkorelasi data topografi. 

 Memanggil data citra SRTM yang telah dipotong (*.shp) dengan 

menggunakan cara klik tombol ―+” kemudian klik Add 

3. Setelah terkumpul semua data, tahap selanjutnya adalah pembuatan kontur curah 

hujan dan kontur topografi yang pada akhirnya digabungkan menjadi satu 

sehingga memperlihatkan kemana arah aliran air dan memperlihatkan juga 

wilayah yang berpotensi tinggi mengalami peristiwa banjir. 

 

III.3.2 Proses Pembuatan Peta Kontur Topografi 

 Data topografi diperoleh dari data DEM SRTM meliputi wilayah Sulawesi 

Selatan, untuk mempermudah maka data kontur yang akan dibuat 

dipersempit menjadi wilayah Kota Makassar, Kabupaten Takalar dan 

Kabupaten Gowa. 

 Untuk memperoleh data DEM hanya pada lokasi penelitian maka 

dilakukan pemotongan data DEM dengan menggunakan Geoprocessing > 

ArcToolbox > Spatial Analyst Tools > Extraction > Extract By Mask.  
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 Untuk membuat kontur topografi Sulawesi Selatan berdasarkan data DEM 

maka digunakan ArcToolbox >  3D Analyst Tools > Raster Surface > 

Contour. 

Hasil kontur dari proses tersebut masih berupa garis kasar karena masih 

berdasarkan perhitungan komputer, untuk memperhalus garis kontur agar 

menyerupai kondisi sebenarnya di lapang maka dilakukan dengan cara, 

pilih Search lalu Tools dan ketikan Smooth Line. 

 

III.3.3 Proses Pembuatan Peta Kontur Curah Hujan 

Kontur pada pengertian analisis spasial adalah garis yang menghubungkan 

sel yang mempunyai nilai sama. Pada proses pembuatan kontur, ArcGIS 

akan membuat garis pada interval tertentu untuk menghubungkan sel-sel 

yang mempunyai nilai sama. Hasil dari proses Create Contour ini secara 

automatis akan diberi nama Contour of . Garis kontur yanag 

menghubungkan curah hujan yang sama disebut garis isohiyet. Garis 

kontur ini dapat dibuat dengan menggunakan theme shapefile titik atau 

theme grid kontinyu. Koordinat didapat langsung dari koordinat stasiun-

stasiun curah hujan dari BMKG. Setelah itu ditentukan nilai x, y dan z nya. 

Nilai x didapat dari nilai bujur atau longitude, nilai y didapat dari nilai 

lintang atau latitude, sedangkan nilai z didapat dari besaran curah hujan 

tiap tahunnya.  
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 Memanggil data koordinat dalam format Excel dengan menggunakan cara  

klik File > Add Data > Add XY Data. 

 Setelah memanggil data koordinat dalam file Microsoft Excelpembuatan 

peta dilakukan menggunakan metode ‗Kriging’ dengan menggunakan cara 

mengetik ‗Kriging‘ di kolom Search.  

III.3.4 Proses Pembuatan Peta Arah Aliran 

Setelah membuat peta kontur curah hujan dan peta kontur topografi 

Setelah membuat peta kontur curah hujan dan peta kontur topografi, yang 

dilakukan selanjutnya adalah membuat peta arah aliran. 

• Memanggil data koordinat dalam Microsoft Excel dengan 

menggunakan cara  klik File > Add Data > Add XY Data. 

• Memanggil data topografi DEM SRTM 

• Memanggil data batas DAS dan data sungai 

• Setelah memanggil semua data, pembuatan arah aliran digunakan 

dengan menggunakan tools ‗Flow Direction’ dengan cara mengklik 

Spatial Analyst Tools > Hydrology > Flow Direction. 

 

III.3.5 Menghitung Debit Aliran 

Menghitung debit aliran menggunakan persamaan (2.1) sebagai berikut: 
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Q = 0,0028. [
  

 
   ] [

  

 
   ]      (2.1) 

Q   = Debit aliran (l/det) 

0,0028 = Konstanta, digunakan jika satuan luas daerah menggunakan Ha 

Ci   = Koefisien aliran menurut tata guna lahan berdasarkan DAS 

Ii   = Intensitas Curah Hujan berdasarkan DAS (mm/bulan) 

Ai  = Luas daerah aliran berdasarkan DAS (Ha) 

A  = Luas daerah aliran (Ha) 
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III.4 Bagan Alir Penelitian 

 

 

 

 

 

  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Gambar 3.2 Bagan Alir Penelitian 
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Peta Kontur didapatkan untuk melihat ketinggian dan perbedaan nilai curah hujan di lokasi penelitian 

Debit Aliran Air menggunakan rumus Q = 0,0028 C I A 

Menentukan nilai Q berdasarkan DAS yang berada di lokasi penelitian 

Mem-validasi semua hasil penelitian 

Penarikan Kesimpulan 

Peta Arah Aliran yang berbentuk panah di overlay dengan data DAS dan Sungai, yang menunjukkan arah aliran air mengalir  

Mulai 

Selesai 
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BAB IV 

HASIL DAN PEMBAHASAN 

Penelitian ini dilakukan untuk mengetahui arah aliran di Kota Makassar, 

Kabupaten Gowa dan Kabupaten Takalar dari tahun 2012 hingga 2017. Dalam 

penelitian ini data yang digunakan adalah data sekunder yang berupa data 

topografi yang meliputi Kota Makassar, Kabupaten Gowa, dan Kabupaten Takalar 

dan data curah hujan periode 2012 hingga 2017.  

IV. 1 Peta Kontur Topografi Lokasi Penelitian 

Data topografi yang didapatkan bersumber dari LAPAN resolusi 30 m – 1 Arc-

Second. Luas wilayahnya kurang lebih 2648,77 km
2
. Dari data topografi tersebut 

maka dapat dibuat peta kontur topografi seperti pada Gambar 4.1. 
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Gambar 4.1 Peta Topografi Lokasi Penelitian 

Dari Gambar 4.1 dapat dilihat bahwa topografi wilayah Kota Makassar, 

Kabupaten Gowa, dan Kabupaten Takalar relatif landai berada pada ketinggian 

745 meter sampai 4279 meter dari ellipsoid bumi. Pada Gambar 4.1 ditunjukkan 

daerah terendah berawarna hijau dengan ketinggian 745 meter sampai 1264 meter, 

sedangkan daerah tertingginya ditunjukkan dengan warna merah dengan 

ketinggian 1995 meter sampai 4279 meter. 

IV. 2 Peta Pos Curah Lokasi Penelitian 

Data curah hujan yang didapatkan bersumber dari BMKG periode 2012 hingga 

2017 di wilayah Kota Makassar, Kabupaten Gowa dan Kabupaten Takalar.  

Dimana ada 11 stasiun curah hujan di wilayah tersebut, yaitu Kantor BBMKG 

Wilayah IV Panaikang Makassar, Pos Hujan Barombong Makassar, Pos Hujan 
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Biring Romang Makassar, Pos Hujan Malino Kabupaten Gowa, Pos Hujan 

Limbung Kabupaten Gowa, Pos Hujan Barembeng Kabupaten Gowa, Pos Hujan 

Cakura Kabupaten Takalar, Pos Hujan Mappakasunggu Kabupaten Takalar, Pos 

Hujan Pattallassang Kabupaten Takalar, Pos Hujan Galesong Kabupaten Takalar 

dan Pos Hujan Takalar Tottallasa Kabupaten Takalar. 

Langkah pertama sebelum membuat peta kontur curah hujan di lokasi penelitian 

yaitu membuat peta Pos curah hujan yang dapat d ilihat pada Gambar 4.2  

Gambar 4.2 Peta Pos Curah Hujan Lokasi Penelitian 

Setelah mengetahui lokasi stasiun-stasiun curah hujan, maka dapat dibuat peta 

kontur curah hujan yang dihasilkan dari overlay data topografi dan data curah 

hujan. 
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Gambar 4.3 (a) Peta Kontur Curah Hujan Bulan Januari, Bulan Februari, Bulan 

Maret, Bulan April, Bulan Mei dan Bulan Juni. 
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Gambar 4.3 (b) Peta Kontur Curah Hujan Bulan Juli, Bulan Agustus, Bulan 

September, Bulan Oktober, Bulan November, Bulan Desember. 
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Pada Gambar 4.3 (a) dan Gambar 4.3 (b) dapat dilihat bahwa kontur curah 

hujan terendah diwakilkan dengan warna biru tua dan kontur curah hujan tertinggi 

diwakilkan dengan warna merah. Setiap bulan mempunyai perbedaan kontur 

curah hujan masing-masing, seperti terlihat pada Gambar 4.3 (a) dan Gambar 

4.3 (b) diatas. Pada bulan Januari, kontur curah hujan terendah sebesar 680,74 

mm hingga dan kontur curah hujan tertinggi sebesar hingga 1.053 mm. Pada bulan 

Februari, kontur curah hujan terendah sebesar 288,65 mm hingga dan kontur 

curah hujan tertinggi sebesar 791,97 mm. Pada bulan Maret, kontur curah hujan 

terendah sebesar 249,46 mm dan kontur curah hujan tertinggi sebesar 696,10 mm. 

Pada bulan April, kontur curah hujan terendah sebesar 181,87 mm dan kontur 

curah hujan tertinggi sebesar 417,74 mm. Pada bulan Mei, kontur curah hujan 

terendah sebesar 55,83 mm dan kontur curah hujan tertinggi sebesar 254,86 mm. 

Pada bulan Juni, kontur curah hujan terendah sebesar 40,59 mm dan kontur curah 

hujan tertinggi sebesar 244,97 mm. Pada bulan Juli, kontur curah hujan terendah 

sebesar 14,35 mm dan kontur curah hujan tertinggi sebesar 175,46 mm. Pada 

bulan Agustus, kontur curah hujan terendah sebesar 2,44 mm dan kontur curah 

hujan tertinggi sebesar 25,33 mm. Pada bulan September, kontur curah hujan 

terendah sebesar 15,48 mm dan kontur curah hujan tertinggi sebesar 40,44 mm. 

Pada bulan Oktober, kontur curah hujan terendah sebesar 12,53 mm dan kontur 

curah hujan tertinggi sebesar 102,76 mm. Pada bulan November, kontur curah 

hujan terendah sebesar 84,90 mm dan kontur curah hujan tertinggi sebesar 181,55 

mm. Pada bulan Desember, kontur curah hujan terendah sebesar 301,02 mm dan 

kontur curah hujan tertinggi sebesar 642,45 mm. 
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IV.3 Peta Penggunaan Lahan 

Penggunaan lahan merupakan faktor yang berhubungan langsung dengan arah 

aliran. Arah aliran sangat dipengaruhi jenis penggunaan lahan. Berikut peta 

penggunaan lahan Kota Makassar, Kabupaten Gowa, Kabupaten Takalar. 

Gambar 4.4 Peta Penggunaan Lahan 
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Tabel 4.1 Tabel Penggunaan Lahan di Kota Makassar, Kabupaten Gowa dan 

Kabupaten Takalar 

 

Jenis Penggunaan Lahan Nilai C Luas (Ha) Luas (%) 

Lahan Terbuka 0,015 1.932 0,76 

Semak-Semak 0,016 37.659 14,85 

Tugu Air 0,01 8.815 3,48 

Pertanian 0,026 127.523 50,29 

Bukit 0,041 1.133 0,45 

Lahan Terbangun 0,059 14.299 5,64 

Hutan 0,07 62.189 24,53 

TOTAL 253.550 100,00 

 

Berdasarkan pada Tabel 4.1 dan Gambar 4.4 dapat dilihat sebagian besar 

wilayah lokasi penelitian merupakan wilayah yang digunakan oleh Pertanian 

dengan luasnya mencapai 127.523 Ha atau 50,29% dari total luas wilayah lokasi 

penelitian, yang merupakan wilayah yang berpotensi tinggi sebagai arah aliran. 

  

IV.4 Distribusi Curah Hujan dan Hari Hujan  

IV.4.1 Distribusi Curah Hujan  

 Curah Hujan 

 Pada tahun 2012 memperlihatkan bahwa nilai curah hujan 

terendah adalah 1269 mm yang terjadi di lokasi Pos Hujan 

Barembeng Kabupaten Gowa, sedangkan nilai curah hujan 

tertinggi adalah 3271 mm yang terjadi di lokasi Pos Hujan 

Limbung Kabupaten Gowa, rentang nilai tersebut termasuk 
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dalam kelas hujan rendah sampai hujan tinggi. Distribusi curah 

hujan tahun 2012 dapat dilihat pada Gambar 4.5. 

 Pada tahun 2013 memperlihatkan bahwa nilai curah hujan 

terendah adalah 2033 mm yang terjadi di lokasi Kantor BBMKG 

Wilayah IV Panaikang Makassar, sedangkan nilai curah hujan 

tertinggi adalah 5346 mm yang terjadidi lokasi Pos Hujan 

Limbung Kabupaten Gowa, rentang nilai tersebut termasuk 

dalam kelas hujan sedang sampai hujan tinggi. Distribusi curah 

hujan tahun 2013 dapat dilihat pada Gambar 4.6. 

 Pada tahun 2014 memperlihatkan bahwa nilai curah hujan 

terendah adalah 1236 mm yang terjadi di lokasi Kantor BBMKG 

Wilayah IV Panaikang Makassar, sedangkan nilai curah hujan 

tertinggi adalah 3765 mm yang terjadi di lokasi Pos Hujan 

Limbung Kabupaten Gowa, rentang nilai tersebut termasuk 

dalam kelas hujan rendah sampai hujan tinggi. Distribusi curah 

hujan tahun 2014 dapat dilihat pada Gambar 4.7. 

 Pada tahun 2015 memperlihatkan bahwa nilai curah hujan 

terendah adalah 1276 mm yang terjadi di lokasi Kantor BBMKG 

Wilayah IV Panaikang Makassar , sedangkan nilai curah hujan 

tertinggi adalah 4048 mm yang terjadi di lokasi Pos Hujan 

Limbung Kabupaten Gowa, rentang nilai tersebut termasuk 

dalam kelas hujan rendah sampai hujan tinggi. Distribusi curah 

hujan tahun 2015 dapat dilihat pada Gambar 4.8. 
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 Pada tahun 2016 memperlihatkan bahwa nilai curah hujan 

terendah adalah 605 mm yang terjadi di lokasi Pos Hujan 

Pattallassang Kabupaten Takalar, sedangkan nilai curah hujan 

tertinggi adalah 4106 mm yang terjadi di lokasi Pos Hujan 

Limbung Kabupaten Gowa, rentang nilai tersebut termasuk 

dalam kelas hujan rendah sampai hujan tinggi. Distribusi curah 

hujan tahun 2016 dapat dilihat pada Gambar 4.9.  

 Dan pada tahun 2017 memperlihatkan bahwa nilai curah hujan 

terendah adalah 327 mm yang terjadi di lokasi Pos Hujan 

Pattalassang, sedangkan  nilai curah hujan tertinggi adalah 3089 

mm yang terjadi di lokasi Pos Hujan Cakura Kabupaten Takalar, 

rentang nilai tersebut termasuk dalam kelas hujan rendah sampai 

hujan tinggi. Distribusi curah hujan tahun 2017 dapat dilihat 

pada Gambar 4.10. 
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Gambar 4.5 Histogram Distribusi Curah Hujan pada Tahun 2012 

Gambar 4.6 Histogram Distribusi Curah Hujan pada Tahun 2013 
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Gambar 4.7 Histogram Distribusi Curah Hujan pada Tahun 2014 

Gambar 4.8 Histogram Distribusi Curah Hujan pada Tahun 2015 
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Gambar 4.9 Histogram Distribusi Curah Hujan pada Tahun 2016 

Gambar 4.10 Histogram Distribusi Curah Hujan pada Tahun 2017 
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IV.4.2 Distribusi Hari Hujan  

 Hari Hujan 

 Pada tahun 2012 memperlihatkan bahwa nilai hari hujan 

terendah adalah 60 hari yang terjadi di lokasi Pos Hujan Takalar 

Tottallasa Kabupaten Takalar, sedangkan nilai hari hujan 

tertinggi adalah 202 hari yang terjadi di lokasi Pos Hujan 

Malino Kabupaten Gowa. Distribusi hari hujan tahun 2012 dapat 

dilihat pada Gambar 4.11. 

 Pada tahun 2013 memperlihatkan bahwa nilai hari hujan 

terendah adalah 102 hari yang terjadi di lokasi Pos Hujan 

Barombong Kota Makassar, sedangkan nilai hari hujan tertinggi 

adalah 359 mm yang terjadi di lokasi Pos Hujan Malino 

Kabupaten Gowa. Distribusi hari hujan tahun 2013 dapat dilihat 

pada Gambar 4.12. 

 Pada tahun 2014 memperlihatkan bahwa nilai hari hujan 

terendah adalah 73 hari yang terjadi di lokasi Pos Hujan 

Pattallassang Kabupaten Takalar, sedangkan nilai hari hujan 

tertinggi adalah 188 hari yang terjadi di lokasi Pos Hujan 

Malino Kabupaten Gowa. Distribusi hari hujan tahun 2014 

dapat dilihat pada Gambar 4.13.  

 Pada tahun 2015 memperlihatkan bahwa nilai hari hujan 

terendah adalah 64 hari yang terjadi di lokasi Pos Hujan 

Takalar Tottallassa Kabupaten Takalar , sedangkan nilai hari 
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hujan tertinggi adalah 162 hari yang terjadi di lokasi Pos Hujan 

Barombong Kota Makassar. Distribusi hari hujan tahun 2015 

dapat dilihat pada Gambar 4.14. 

  Pada tahun 2016 memperlihatkan bahwa nilai hari hujan 

terendah adalah 98 hari yang terjadi di lokasi Pos Hujan 

Pattallassang Kabupaten Takalar, sedangkan nilai hari hujan 

tertinggi adalah 228 hari yang terjadi di lokasi Pos Hujan 

Malino Kabupaten Gowa. Distribusi hari hujan tahun 2016 

dapat dilihat pada Gambar 4.15. 

 Dan pada tahun 2017 memperlihatkan bahwa nilai hari hujan 

terendah adalah 27 hari yang terjadi di lokasi Pos Hujan 

Mappakasunggu Kabupaten Takalar, sedangkan nilai hari 

hujan tertinggi adalah 146 hari yang terjadi di lokasi Pos Hujan 

Malino Kabupaten Gowa. Distribusi hari hujan tahun 2017 

dapat dilihat pada Gambar 4.16 
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Gambar 4.11 Histogram Distribusi Hari Hujan pada Tahun 2012 

Gambar 4.12 Histogram Distribusi Hari Hujan pada Tahun 2013 
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Gambar 4.13 Histogram Distribusi Hari Hujan pada Tahun 2014 

Gambar 4.14 Histogram Distribusi Hari Hujan pada Tahun 2015 
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Gambar 4.15 Histogram Distribusi Hari Hujan pada Tahun 2016 

Gambar 4.16 Histogram Distribusi Hari Hujan pada Tahun 2017 
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IV.5 Peta Arah Aliran 

Hasil pemetaan dapat dilihat bahwa arah aliran wilayah Kota Makassar, 

Kabupaten Gowa, dan Kabupaten Takalar cenderung mengalir ke dataran rendah 

yang berupa sungai-sungai dan cabangnya.. Pada Gambar 4.17, panah 

menunjukkan arah aliran sedangkan garis berwarna biru menunjukkan sungai dan 

cabang-cabangnya, terdapat 7 DAS yang diwakilkan dengan berbagai warna yaitu 

DAS Sungai Jeneberang diwakilkan dengan warna kuning, DAS Sungai Jenelata 

diwakilkan dengan warna merah, DAS Binangapapa diwakilkan dengan warna 

hijau tua, DAS Sungai Tallo diwakilkan dengan warna ungu, DAS Binanga 

Cikoang diwakilkan dengan warna biru, DAS Sungai Tangka diwakilkan dengan 

warna abu-abu dan DAS Jene Ponto diwakilkan dengan warna oranye.  

Gambar 4.17 Peta Arah Aliran Lokasi Penelitian 
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IV.6 Debit Aliran Air 

Tabel 4.2 Debit Aliran Air (l/detik) 

 

Pada Tabel 4.2 dapat dilihat apabila dibandingkan berdasarkan lokasi DAS nilai 

debit maksimum ada pada lokasi DAS Sungai Jeneberang yang ditandai dengan 

warna biru, sedangkan nilai debit minimum ada pada lokasi DAS Binangapapa 

yang ditandai dengan warna oranye. Sedangkan apabila dibandingkan berdasarkan 

bulan, nilai debit aliran beragam. Pada DAS Sungai Jeneberang nilai debit 

maksimum ada pada bulan Januari dengan nilai 1,77 l/detik dan nilai debit 

minimum ada pada bulan Desember dengan nilai 1,09 l/detik. Pada DAS Sungai 

Jenelata nilai debit maksimum ada pada bulan Januari dengan nilai 0,61 l/detik 

dan nilai debit minimum ada pada bulan Desember dengan nilai 0,3 l/detik. Pada 

DAS Sungai Tangka nilai debit maksimum ada pada bulan Februari dengan nilai 

0,8 l/detik dan nilai debit minimum ada pada bulan Desember dengan nilai 0,37 

l/detik. Pada DAS Binanga Cikoang nilai debit maksimum ada pada bulan 

November dengan nilai 1,2 l/detik dan nilai debit minimum ada pada bulan Mei 

dengan nilai 0,5 l/detik. Pada DAS Sungai Tallo nilai debit maksimum ada pada 

Nama DAS 
Q (l/det) 

Jan Feb Mar Apr Mei Jun Jul Agt Sep Okt Nov Des 

DAS S. Jeneberang 1,77 1,6 1,43 1,572 1,5 1,58 1,4 1,31 1,5 1,2 1,6 1,09 

DAS S. Jenelata 0,61 0,6 0,47 0,58 0,5 0,47 0,5 0,44 0,6 0,4 0,6 0,3 

DAS S. Tangka 0,64 0,8 0,7 0,67 0,7 0,73 0,7 0,7 0,7 0,6 0,7 0,37 

DAS Binanga Cikoang 1,04 0,7 0,58 0,844 0,5 0,52 0,7 0,55 1,1 1,1 1,2 0,74 

DAS S. Tallo 0,65 0,6 0,55 0,578 0,7 0,63 0,6 0,35 0,6 0,7 0,6 0,6 

DAS Jeneponto 1,07 1,1 0,94 1 0,8 0,89 1 0,92 1,2 0,8 1,1 0,6 

DAS Binangapapa 0,53 0,1 0,12 0,14 0,1 0,09 0,1 0,07 0,1 0,2 0,2 0,24 
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bulan Mei dengan nilai 0,7 l/detik dan nilai debit minimum ada pada bulan 

Agustus dengan nilai 0,35 l/detik. Pada DAS Jeneponto nilai debit maksimum ada 

pada bulan September dengan nilai 1,2 l/detik dan nilai debit minimum ada pada 

bulan Desember dengan nilai 0,6 l/detik. Dan pada DAS Binangapapa nilai debit 

maksimum ada pada bulan Januari dengan nilai 0,53 l/detik dan nilai debit 

minimum ada pada bulan Agustus dengan nilai 0,07 l/detik. 

Gambar 4.18 (a) Peta Arah Aliran Berdasarkan Nilai Debit Bulan Januari 
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Gambar 4.18 (b) Peta Arah Aliran Berdasarkan Nilai Debit Bulan Februari 

Gambar 4.18 (c) Peta Arah Aliran Berdasarkan Nilai Debit Bulan Maret 
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Gambar 4.18 (d) Peta Arah Aliran Berdasarkan Nilai Debit Bulan April 

Gambar 4.18 (e) Peta Arah Aliran Berdasarkan Nilai Debit Bulan Mei 
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Gambar 4.18 (f) Peta Arah Aliran Berdasarkan Nilai Debit Bulan Juni 

Gambar 4.18 (g) Peta Arah Aliran Berdasarkan Nilai Debit Bulan Juli 
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Gambar 4.18 (h) Peta Arah Aliran Berdasarkan Nilai Debit Bulan Agustus 

Gambar 4.18 (i) Peta Arah Aliran Berdasarkan Nilai Debit Bulan September 
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Gambar 4.18 (j) Peta Arah Aliran Berdasarkan Nilai Debit Bulan Oktober 

Gambar 4.18 (k) Peta Arah Aliran Berdasarkan Nilai Debit Bulan November 
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Gambar 4.18 (l) Peta Arah Aliran Berdasarkan Nilai Debit Bulan Desember 

Gambar 4.18 Peta Arah Aliran Berdasarkan Nilai Debit 
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BAB V 

PENUTUP 

V. 1 Kesimpulan 

Berdasarkan pada hasil penelitian tentang distribusi pengaliran presipitasi 

berdasarkan topografi di wilayah Kota Makassar, Kabupaten Gowa dan 

Kabupaten Takalar dapat disimpulkan hal-hal sebagai berikut: 

1. Hasil pemetaan kontur curah hujan menunjukkan  nilai curah hujan 

pada tahun 2012 antara 1269 mm/tahun hingga 3271 mm/tahun, pada 

tahun 2013 antara 2033 mm/tahun hingga 5346 mm/tahun, pada tahun 

2014 antara 605 mm/tahun hingga 4106 mm/tahun, pada tahun 2015 

antara 1236 mm/tahun hingga 3765 mm/tahun, pada tahun 2016 antara 

1276 mm/tahun hingga 4048 mm/tahun, dan pada tahun 2017 antara 

327 mm/tahun hingga 3089 mm/tahun. Sedangkan pada hasil 

pemetaan kontur curah hujan pada tahun 2012 hingga tahun 2017 

menunjukkan nilai total dari keseluruhan curah hujan antara 327 

mm/tahun hingga 5346 mm/tahun. 

2. Hasil pemetaan kontur topografi menunjukkan nilai kontur antara 745 

meter hingga 4279 meter. Dengan daerah terendah yang memiliki nilai 

ketinggian 745 meter hingga 1264 meter dan daerah tertinggi yang 

memiliki nilai  ketinggian antara 1995 meter hingga 4279 meter.  

3. Hasil dari pemetaan arah aliran menunjukkan bahwa aliran akan 

bergerak terus menuju dataran rendah atau lembah. Seperti pada hasil 
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pemetaan, menunjukkan air terus bergerak ke dataran rendah, dalam 

hal ini dataran rendah yang dimaksud adalah sungai-sungai besar 

beserta cabangnya. 

4. Hasil perhitungan debit aliran air berdasarkan lokasi DAS, nilai debit 

maksimum ada pada lokasi DAS Sungai Jeneberang, sedangkan nilai 

debit minimum ada pada lokasi DAS Binangapapa. Sedangkan 

perhitungan debit aliran air berdasarkan bulan, nilai debit maksimum 

ada pada DAS Sungai Jeneberang pada bulan Januari dengan nilai 

1,771 l/detik dan nilai debit minimum terletak pada DAS Binangapapa 

dengan nilai 0,073 l/detik. 

V. 2 Saran 

Adapun saran untuk penelitian selanjutnya, yaitu: 

 Sebaiknya penelitian ini dilanjutkan dengan melihat pengaruh 

dari beberapa parameter lain, misal periode waktu curah hujan 

serta hari hujan yang lebih lama.  

 Apabila penelitian selanjutnya menggunakan data curah hujan, 

sangat disarankan untuk mengambil data intensitas curah hujan 

per jam.  
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